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ABSTRACT 

Now a days with increasing use of communication devices, signal trafficking over a particular 

band increasing. In order to overcome these kind of issues, cognitive radio was introduced. A 

cognitive radio is a radio that can be programmed and configured dynamically to use the best 

wireless channels in its surroundings to avoid user interference and congestion. It will scan 

throughout the spectrum and find the free slots over any particular bands and start transmission 

or receiving signal the proposed work is focused on achieving Spectrum sensing and signal 

transmission or reception over a single band through switching technique. So, we introduce a six-

switch integrated ultrawideband (UWB) frequency reconfigurable system. Switching property 

can be achieved by inserting pin diodes or RF-MEMS switches. This design mainly finds the 

applications of cognitive radios such as cellular networks, medical purposes and aviation etc.,  
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                                     CHAPTER  1 

SWITCHABLE MICROSTRIP PATCH ANTENNA              

1.1 INTRODUCTION 

Microstrip antennas received considerable attention starting in the 1970s, although the idea of 

microstrip antenna can be traced to 1953 [1] and a patent in 1955 [2]. One of the major benefits 

of microstrip antenna is that they are very comfortable to planar and non-planar surfaces. This 

was the main reason that the microstrip antenna acquired the serious attention to the researchers 

in early 1970s when high performance application such as aircraft, spacecraft, missile, satellite 

communication put the motivation for researchers to investigate on usefulness of conformal 

microstrip antennas. After about 2 years Howell introduced a basic rectangular shape microstrip 

antenna that was fed using the microstrip transmission line. In that days microstrip antenna was a 

major focus for investigators. Researchers introduced many various designs. But it was difficult 

to get the better radiation efficiency that was limited up to 90%. Narrow bandwidth was also a 

severe problem for microstrip antenna. 

1.2 STRUCTURE: 

In a most basic form a microstrip antenna comprises of two thin metallic layers           (t ˂˂𝜆𝜆0 , 

where 𝜆𝜆0 is wavelength in free space) one as radiating patch and second as ground plane and a 

dielectric substrate is placed between them. The conductor patch is placed on the dielectric 

substrate and used as radiating element. On the other side of the substrate there is a conductive 

layer used as ground plane as represented in Fig.1.2. Copper and gold is used normally as a 

metallic layer. Radiating patch can be of any shape but simple shapes are used to design a patch 

because patches basic shapes are easy to analysis by the available theoretical models and it is 

easy to predict the performance. Square, rectangular, dipole, triangular, elliptical, circular are 

some basic shapes. Circular, rectangular and dipole are the most often used shapes because of 

easy of analysis and fabrication. A variety of dielectric materials are available for the substrate 

with dielectric constants 2.2≤ ԑ𝑟𝑟 ≥ 12. The height of substrate plays an important role in antenna 

characteristics generally are in the range 0.003𝜆𝜆0 ≤ h ≥ 0.05𝜆𝜆0 



                                                 
Fig.1.1: Basic Microstrip Antenna 

An antenna characteristics is not only depends on the antenna element but also be influenced by 

the TX-line and antenna combination. Generally the input impedance of microstrip antenna is 

complex and the characteristic impedance of TX-line is real (usually 50 ohm). This will results in 

impedance mismatching and causes a voltage standing wave pattern on transmission line results 

in low impedance bandwidth. One way to overcome this problem is use of impedance matching 

networks between antenna and transmission line. There are several impedance matching 

techniques are available, Circuit theory deals with the impedance matching techniques. 

Microstrip antenna suffers from very Narrow frequency bandwidth. However some application 

where narrow bandwidth is essential such as government security systems, microstrip antennas 

are useful. Bandwidth of microstrip antenna is directly proportional to height of substrate. There 

are two main techniques two improve the Structural technique deals with the modification of 

substrate properties such as height and dielectric constant. By increasing the height we can 

increase the bandwidth. But it will also introduce surface waves which increases loss of the 

power and leads to performance and characteristics degradation. Various types of methods are 

introduced by the researchers such as stacking, defected ground plane, parasitic patches and 

improvement of bandwidth of microstrip antenna is still an interesting topic for investigation. By 

choosing a particular shape one can easily design an antenna with desired resonance frequency 

radiation pattern, polarization. It is easy to design a microstrip antenna with reconfigurable 

polarization, resonance frequency and radiation patterns just by adding loads like PIN diode, 

Varactor diodes. 

1.3Configurations: 

Since the early development of microstrip antenna until now, variety of configurations have been 



produced and investigated to improve the performance of microstrip antenna as shown in Fig. 

1.2. Some of the common shapes are rectangle; triangle and circular are shown in figure. Several 

shapes such as pentagon and ellipse are known to give circular polarization [3].  

        

               Fig  1.2 Different shape of microstrip patch antenna 

 

1.4 Advantages and Disadvantages: 

Microstrip antenna is a low profile antenna that has light weight and is very easy to installation 

due to which it is very popular in handheld wireless devices such as cell phones, pagers and in 

some high performance communication systems such as in satellite, missile, spacecraft, aircraft 

etc. Some of the major advantages of microstrip antenna as discussed by Ramesh Garg [4] are 

given below: 

• Inexpensive and easy to fabricate.  

• Can be planted easily on any surface.  
 

• Can easily get reconfigurable characteristics.  
 

• Can easily design antenna with desired polarization.  
 

• Mechanically robust, Resistant against vibration and shock.  
 

• Suitable to microwave integrated circuits (MICs).  
 

• For high gain and directivity Array of antennas can be easily formed.  

Conversely microstrip antennas also have a number of disadvantages and limitations when 



compared to other antennas. Some of the major disadvantages of microstrip antennas are written 

below: 

• High quality factor.  
 

• Cross polarization.  
 

• Poor polarization efficiency.  
 

• Suffers from spurious feed radiation.  
 

• Narrow impedance bandwidth (5% to 10% without any technique)  
 
There are various methods to overcome this limitations, bandwidth of microstrip antenna can be 
increase by using some special methods like defected ground plane strategy, stacked patches, 
slotted patches, parasitic patch. Gain and the power handling ability of antenna can be improved 
by making an antenna array. Use of Electromagnetic Band Gap (EBG) structure and met material 
also results in the improvement of the antenna characteristics [4] 

1.5 Feeding Techniques: 

Feeding methods can be dividing in two categories one is contacting feeds and other one is non 

contacting feeds or electromagnetic coupled feed. In contacting feeds the feed line is directly 

connected to radiating element. The main drawback of contacting feeds are that it shows inherent 

asymmetry which produces the higher order modes that leads to increase in cross polarization 

level. To minimize these non-contacting feeds are used. Microstrip line feed and coaxial probe 

feeding are two mainly used direct contact feedings and aperture coupled and proximity coupling 

are two non-contacting couplings which are described in brief below: 

1.5.1 Microstrip probe feed: 



                     

                         Fig. 1.3: Microstrip linefeed 

In this type of feeding the radiating patch is directly fed by the microstrip feed line has a narrow 

width as compare to patch as shown in Fig. 1.4. It is the simple and mostly used feeding method. 

Because microstrip line can be treated as extended part of radiating patch and fabricated on the 

same substrate on the board. This feeding simple to fabricate and it’s easy to impedance 

matching techniques are very compatible with this type of feed. But this feed also have some 

drawbacks, suffers from spurious feed radiation and surface wave losses also has low bandwidth 

1.5.2 Coaxial probe feed: 

One of the widely used feeding for microstrip antenna. In this type of feeding core of coaxial 

cable is directly connected to the patch using the soldering and the outer cable are connected to 

the ground. Core conductor is inserted in the substrate via a hole. The main advantage of this 

feeding is that we can directly feed or connect the inner conductor to the feed point where the 

input impedance is equal to the characteristic impedance of the feed line as shown in Fig. 1.4. 



                            

                                                 Fig. 1.4: Probe Feed 

1.5.3 Proximity coupled feed: 

Two types of dielectric substrates are used in this type of feeding. Microstrip line is not directly 

connected to patch and left open ended and is sandwiched between the substrates. Energy from 

feed line is coupled electromagnetic to the radiating patch. The microstrip line can be extended 

as stub to increase the bandwidth. Substrates dielectric constants play a lead role and selected to 

increase the bandwidth and decrease the spurious feed radiations from the feed line. Structural 

view of this type of feeding is shown in Fig. 1.5. 

 
                                Fig. 1.5: Proximity-Coupled feed 

Thick Material with low dielectric constant is selected for Upper substrates because lower the 

dielectric constant more the fringing field and more the radiations from patch and thin substrate 

with high dielectric constant is selected for lower substrate. This type of feeding has largest 



bandwidth as compared to others. It is easy to model and has low spurious feed radiation 

however its fabrication is more difficult because the exact alignment of feed line is required. The 

length of the extended stub and width to line ratio of patch can be optimized to control the 

antenna characteristics. 

1.5.4 Aperture coupled feed: 

Structural view of this type of feeding is shown in Fig. 1.6. As shown this feeding also uses two 

type of substrate ground plane is placed between them and microstrip line is used generally to 

feed which is placed below the lower substrate.  

 

 
                                Fig. 1.6: Aperture-Coupled feed 

Aperture coupling feeding the energy is electromagnetically coupled to the patch through an 
aperture or slot made in the ground plane. Different types of aperture shapes are used generally 
rectangular and circular shapes are widely used. Cross shaped and annular ring shape slots are 
used for exciting the circular polarization. The parameters of slots are used to improve the 
antenna characteristics. As in proximity coupled feeding substrates dielectric constant is selected 
to get better radiation and bandwidth. Thick substrate with low dielectric constant is used for the 
upper substrate to get the good radiation and bandwidth. While thin and high dielectric constant 
material is used for the upper substrate to for efficient transfer of energy from feed line to patch. 
To get the maximum coupling between feed structure and the patch slot should be located at the 
place where the magnetic field is maximum. We know that from the current and voltage 
distribution along the patch length, electric field is maximum at the ends and magnetic field is 
maximum at the centre of the patch. The microstrip feed line is extended a length extra and is 



used as a stub. Stub works as an open circuited transmission line has admittance is in parallel to 
that of the slot. By optimizing the extended length of feed line (stub) the reactive components of 
slot can be cancelled out to that of the stub that will result in better impedance matching. 
 

 

Fig. 1.7: Equivalent Circuits for Feeding Techniques 
 

The area of slot is kept small to minimize the radiation below the ground plane. This type of 

feeding has better polarization purity, low spurious feed radiation and large bandwidth as 

compared to microstrip and coaxial probe feeding. The equivalent circuit for each of them is 

shown in Fig. 1.7 above.  

1.6 Methods of Analysis: 

There are many methods of analysis for microstrip antennas. The most popular models are the 

transmission model [5] and cavity model [6] and full wave [7] (which include primarily 

integrations/moment methods). The transmission line model is the easiest of all, it gives good 

physical insight, but is less accurate and it is more difficult to model coupling. Compared to 

transmission line model, the cavity model is more accurate at the same time more complex. 

However it gives also physical insight and is rather difficult to model coupling, although it has 



been used successfully. In general, when applied properly, the full wave models are accurate, 

very versatile and can treat single elements, finite and infinite arrays, stacked elements, arbitrary 

shaped elements, and coupling. However they are the most complex models and usually give less 

physical insight. In this section we will cover the transmission-line and cavity models only. 

1.6.1 Rectangular Patch Antenna: 

The rectangular microstrip patch is by far the most widely used configuration. It is very easy to 

analyze using both the transmission-line and cavity models, which are most accurate for thin 

substrates. We begin with the transmission-line model because it is easier to illustrate. 

1.6.1.1 Transmission Line Model: 

 
The transmission line model treated rectangular microstrip as a part of transmission line. As the 

rectangular microstrip antenna consists two radiating slots, transmission line model represents 

each radiating slots by an equivalent admittance which are separated by a distance equal to the 

length. The resistive part of them represents the radiation loss from the each slot. At the 

resonance the reactive part of the input impedance cancelled out and the input impedance 

become pure resistive. Transmission line model consider the effects of various parameters 

described below. 

a. Fringing Field: 
 
The fringing field in rectangular microstrip antenna as shown in Fig. 1.9 arises from the radiating 

edges shown in the figure below. Fringing field are mainly depends on the dielectric constant 

and length L to height h ratio. Since in most of the cases the L/h ratio is << 1 therefore the 

fringing fields are less. 

 

 

 

 

 

 

Fig. 1.8:  Fringing Field Effect 



Higher dielectric constant substrate leads to bounded electric fields more enclosed in the 

substrate as used in the microstrip lines. While the lower dielectric constants substrates results in 

loosely bounded electric fields means they will go more further from the patch. Lesser the 

dielectric constant material used in substrate more bowed the fringing fields. We know that the 

fringing fields are responsible for the radiations from microstrip antenna. Therefore lower 

dielectric constant more the fringing fields and more the radiations leads to better efficiency and 

better antenna performance. From figure it can be seen that fringing fields lines are not only 

enclosed in substrate but also go further out in the air. As the field lines travels in substrate and 

air also we have to calculate an Effective Dielectric constant by taking the air also in account as 

shown in Fig. 1.9. 

 
Fig. 1.9:  Effective Dielectric constant 

The effective dielectric constant is a dielectric constant of the material for which the antenna 

characteristics are same as for the real one. The range of effective dielectric constant varies from 

1˃ 𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟˂ 𝜀𝜀𝑟𝑟 . In most cases the 𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 value is close to 𝜀𝜀𝑟𝑟 . If the air is used as a substrate then 

the effective dielectric constant is equal to dielectric constant 𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 =𝜀𝜀𝑟𝑟. The 𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 is also 

depends on frequency. As the operating frequency increases the value of effective dielectric 

constant reaches to the real value of dielectric material used. Fig. 1.10 below showing the 

variation of effective dielectric constant with the frequency below. 



 
Fig. 1.10: Effective Dielectric constant Vs Frequency 

For the lower frequency the effective dielectric constant does not varies but as the frequency 

increases the effective dielectric constant approaches towards the actual dielectric constant of 

substrate material. 

The 𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 for W/h>1 can be given by equation 1.1 

                                        𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 =  
𝜀𝜀𝑟𝑟 + 1

2
+
𝜀𝜀𝑟𝑟 − 1

2
 (1 + 12ℎ/𝑊𝑊)

−1
2                            … .1.1 

b. Effective Length, Resonant Frequency, and Effective Width: 

Because of the fringing effects, electrically the patch of the microstrip antenna looks greater than 

its physical dimensions. Where the dimensions of the patch along its length have been extended 

on each end by a distance ∆L, which is a function of the effective dielectric constant ∈𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 and 

the width-to-height ratio (W/h). A very popular and practical approximate relation for the 

normalized extension of the length is given by equation 1.2 

                                       
∆𝐿𝐿
ℎ

= 0.412
�𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 + 0.3�(𝑊𝑊ℎ + 0.264)

�𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟 − 0.258�(𝑊𝑊ℎ + 0.8)
                                 … .1.2 

Since the length of the patch has been extended by ∆L on each side, the effective length of the 

patch as shown in Fig. 1.11. 



 
Fig. 1.11: Length Extension 

This ∆𝐿𝐿 value mainly depends on the effective dielectric constant and the width to height ratio. 

Due to this length extension length of patch is about 0.48λ rather than 0.5λ. Therefore to get the 

actual physical length of the patch equal to λ/2 we have consider the extension on both the ends 

and that is, the length of the patch is given by equation 1.3   

                                                      𝐿𝐿 =  𝐿𝐿𝑒𝑒𝑒𝑒𝑒𝑒 −  2∆𝐿𝐿                                                           … .1.3 

As we know for dominant mode the length of patch is equal to λ/2 therefore the 𝐿𝐿𝑒𝑒𝑒𝑒𝑒𝑒 is 

given by equation 1.4, 1.5 

                                                             𝐿𝐿𝑒𝑒𝑒𝑒𝑒𝑒 =
𝑐𝑐
𝑓𝑓𝑟𝑟

                                                                  … .1.4 

                                                           𝐿𝐿𝑒𝑒𝑒𝑒𝑒𝑒 =
𝐶𝐶0

2𝑓𝑓𝑟𝑟�𝜀𝜀𝑒𝑒𝑒𝑒𝑒𝑒 
                                                     … .1.5 

Where 𝐶𝐶0 is the velocity of light in free space and 𝑓𝑓𝑟𝑟 is the resonance frequency for which 

antenna is to be design. 

For the dominant mode 𝑇𝑇𝑇𝑇010 there is no fringing fields along the width therefore there is no 

need to consider the effective dielectric constant. Width of the patch can be calculated by this 

formula is given by equation 1.6. 

                                                  𝑊𝑊 =  𝐶𝐶0
2𝑓𝑓𝑟𝑟

(𝜀𝜀𝑟𝑟+1
2

)
−1
2                                                         … .1.6 



For the dominant mode 𝑇𝑇𝑇𝑇010 the antenna resonates (without taking fringing into account) at the 

frequency given by equation 1.7. 

                                                           𝑓𝑓𝑟𝑟 =  
𝐶𝐶0

2𝐿𝐿�𝜀𝜀𝑟𝑟𝑟𝑟𝑟𝑟𝑟𝑟
                                                         … .1.7 

And when considering the effective length and effective dielectric constant the antenna will 

radiate at the frequency. 

c. Input impedance: 

It is important for the perfect impedance matching to find the point along with the patch 

dimension where the input impedance is equal to that of that of the feed line referred as Feed 

point or Driving point. The input impedance at feed point or driving point is known as Driving 

Point Impedance. The current and voltage distribution over the patch length is shown in figure. 

Voltage is maximum at the corners and current is maximum at the centre. As we know that the 

resistance is the ratio of voltage and current. Therefore the resistance will be maximum at the 

corners and minimum at the centre. 

Input impedance of the rectangular patch antenna along the centre line at any point can be 

determined by the transmission line model. The transmission line model for rectangular patch 

antenna is shown in figure. Each radiating edge is shown by parallel equivalent admittance 𝑦𝑦𝑒𝑒 

and is separated by a distance equal to length L =λ/2. The edge admittance consist equivalent 

conductance 𝐺𝐺𝑒𝑒  and susceptance 𝐵𝐵𝑒𝑒. The feed point is located L1 distance away from edge. 

Input admittance 𝑦𝑦𝑖𝑖𝑖𝑖 at the end of a L length long transmission line with characteristic 

admittance 𝑦𝑦𝑜𝑜 can be given by equation 1.8. 

                                                𝑦𝑦𝑖𝑖𝑖𝑖 = 𝑦𝑦𝑜𝑜
𝑦𝑦𝑙𝑙 + 𝑗𝑗𝑦𝑦𝑜𝑜tan (𝐵𝐵𝐵𝐵)
𝑦𝑦𝑜𝑜 + 𝑗𝑗𝑦𝑦𝑙𝑙tan (𝐵𝐵𝐵𝐵)

                                                … .1.8 

Where β is the phase constant. Using the above equation the input impedance at the driving point 

can be expressed by equation 1.9 

                        𝑦𝑦𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑𝑑 = 𝑦𝑦𝑜𝑜 �
𝑦𝑦𝑒𝑒 + 𝑗𝑗𝑦𝑦𝑜𝑜 tan(𝐵𝐵𝐿𝐿1)
𝑦𝑦𝑜𝑜 + 𝑗𝑗𝑦𝑦𝑒𝑒 tan(𝐵𝐵𝐿𝐿1) +

𝑦𝑦𝑒𝑒 + 𝑗𝑗𝑦𝑦𝑜𝑜 tan(𝐵𝐵𝐿𝐿2)
𝑦𝑦𝑜𝑜 + 𝑗𝑗𝑦𝑦𝑒𝑒 tan(𝐵𝐵𝐿𝐿2)�         … .1.9 

The total input admittance at the corner of patch is given by equation 1.10-1.14 



                                                                𝑦𝑦𝑖𝑖𝑖𝑖 = 2𝑦𝑦𝑒𝑒                                                            … .1.10 

Where, 

                                                                  𝑦𝑦𝑒𝑒 = 𝐵𝐵𝑒𝑒 + 𝐺𝐺𝑒𝑒                                                     … .1.11 

Approximated values of 𝐺𝐺𝑒𝑒 and 𝐵𝐵𝑒𝑒 can be given by 

                                                         𝐺𝐺𝑒𝑒 = 0.00836
𝑤𝑤
𝜆𝜆0

                                                      … .1.12 

                                              𝐵𝐵𝑒𝑒 = 0.01668
∆𝐿𝐿
ℎ
𝑤𝑤
𝜆𝜆0

 𝜀𝜀𝑟𝑟𝑒𝑒𝑓𝑓𝑓𝑓                                                … .1.13 

At the resonance the imaginary parts of the edge admittance are equal and out of phase and they 

will cancel out each other. So the total input admittance at the edge at resonance become real and 

is equal to  

                                                           𝑦𝑦𝑖𝑖𝑖𝑖 = 2𝐺𝐺𝑒𝑒                                                                 … .1.14 

So at the resonance the total input impedance become pure real, the equation given by equation 

1.15 

                                                        𝑅𝑅𝑖𝑖𝑖𝑖 = 1/2𝐺𝐺𝑒𝑒                                                               … .1.15 

When we consider the mutual conductance into account then the input impedance will become as 

in equation 1.16-1.17 

                                                  𝑅𝑅𝑖𝑖𝑖𝑖 = 1/(2𝐺𝐺𝑒𝑒 ± 𝐺𝐺12)                                                    … .1.16 

                                    𝐺𝐺12 = 1
120𝜋𝜋2 ∫ �

sin (𝑘𝑘𝑜𝑜𝑤𝑤2 𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐)

𝑐𝑐𝑐𝑐𝑐𝑐𝑐𝑐
�
2

𝜋𝜋
0 𝐽𝐽0(𝑘𝑘0𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿𝐿)𝑠𝑠𝑠𝑠𝑠𝑠3𝜃𝜃𝜃𝜃𝜃𝜃       … .1.17 

Using the model expansion analysis the input resistance at a point 𝑦𝑦0 away from the edge of 

patch along the centre line can be calculated by the equation1.18. 

                                              𝑅𝑅𝑖𝑖𝑖𝑖(𝑦𝑦=𝑦𝑦0) =
1

(2𝐺𝐺𝑒𝑒 ± 𝐺𝐺12)
𝑐𝑐𝑐𝑐𝑐𝑐2 �

𝜋𝜋
𝐿𝐿
𝑦𝑦0�                             … .1.18 

The Fig. 1.12 represents the graph below shows that the input impedance of the rectangular patch 

antenna varies according to square of cosine. 



 
Fig. 1.12 Normalized input Resistance 

1.6.1.2 Cavity Model: 

The cavity model first described by Lo et al. in. late 1970s. As the name says cavity model 

treated the rectangular patch antenna as a cavity with electric walls above and below at metallic 

patch and ground plane, and magnetic walls along the edges of patch. 

 
Fig. 1.13: Rectangular patch for cavity model 

The field under the patch is the summation of the resonance modes created by these radiating 

walls. The cavity model based on the assumption that only z-axis component of electric field and 

x and y-axis components of magnetic field exist. A simple rectangular antenna used for the 

calculation in cavity model is shown in Fig. 1.13. 

1.7 DESIGN EQUATIONS 

The three important parameters while designing the antenna are 

1. Operating frequency (𝑓𝑓𝑟𝑟) 

2. Dielectric constant (𝜀𝜀𝑟𝑟) 

3. Substrate thickness (h) 



By using above three parameters, the dimensions of an antenna can be determined by using the 

below equations 

Width of the patch (W) is given by equation (2.1) 

W =  
C0
2fr

(
εr + 1

2
)
−1
2                                                                   … . (2.1)   

The length of the patch is given by equation (2.2)  

L =  Leff −  0.824
(εreff + 0.3) �W

h + 0.264�

(εreff − 0.258) �W
h + 0.8�

                             … . (2.2) 

Where  𝐿𝐿𝑒𝑒𝑒𝑒𝑒𝑒 is the effective length of the patch. 

            𝜀𝜀𝑒𝑒𝑒𝑒𝑒𝑒  is the effective dielectric constant. 

The effective length of the patch (𝐿𝐿𝑒𝑒𝑒𝑒𝑒𝑒) is given by equation (2.3) 

Leff =
C0

2fr�εeff 
                                                                 … . (2.3) 

Where 𝐶𝐶0 is the velocity of light in free space  

          𝑓𝑓𝑟𝑟 is the resonance frequency for which case is to be design. 

The effective dielectric constant (𝜀𝜀𝑒𝑒𝑒𝑒𝑒𝑒) is given by equation (2.4) 

εreff =  
εr + 1

2
+

εr − 1
2

 (1 + 12h/W)
−1
2                         … . (2.4) 

Example: Design a microstrip patch with dimension w and l over a single substrate, whose center 
frequency is 10GHZ. The distance constant of the substrate is 10.2 and the height of the substrate 
is 0.127cm.  

                            Given that 

                                  Fr = 10GHz, Er = 10.2 & H = 0.127cm  

    Find w and l: 



                       W = (λ0/2) *√ (ꞓr +1)/2  

                             = 6.33cm 

       And   ꞓeff= (ꞓr + 1)/2 + ((ꞓr - 1)/2 * (1/√1 +12(H/W))  

                        = 8.09 

                 ΔL = [0.412H*(εeff+0.3)*(W/H+0.264)] / [(εeff-0.258)*(W/H + 0.8)] 

                       = 5cm 

 

Where: 

                       

                            = 5.2 cm 

Then  

          L = Leff - 2 ΔL    

             = 4.2cm             

                                  

 

 

 

 

 

 

 

 

 

 



                                                         CHAPTER 2 

WORKING ON HFSS SOFTWARE 

2.1 INTRODUCTION 

HFSS stands for stands for high frequency structure simulator. This software basically 

teardowns a structure into multiple tiny substructures, Hence the name Finite Element Method 

(FEM). With its user friendly environment, it’s very easy to understand right from out of the 

box. HFSS can be used to calculate parameters such as S-Parameters, Resonant Frequency, and 

Fields. HFSS can also be used for solving 3D EM problems with ease and results are obtained 

with high accuracy. 

SIMULATION WORKFLOW 

The figure given below depicts the design process in HFSS. these are the six steps required to 

resolve a proper HFSS simulation. 

Design workflow: 

 

 

 

 

 

 

 

 

 

 

 

        

 

 

 

Solution type 

Boundaries 

Excitations 

Analyze 

Parametric Model 
Geometry/Materials 

Analysis 
Solution Setup 
Frequency sweep 

Mesh 
Operations 

Mesh 
Refinement Solve 



 

 

 

 

 

 

 

2.1.1 Create model/geometry: 

The primary step in creating an HFSS model is to make a physical model of our choice. Using 

3D modeller built-in in HFSS, we can design a structure with desired dimensions and material 

properties. We can also import 3D structures into HFSS. Nevertheless, these imported projects 

do not hold on to any history of their creation. Hence the parameters are unmalleable unless its 

modified manually. 

 

In order to use HFSS, one has to initially specify the type of solution that needs to calculated. 

There are three types of solutions: 

1. Driven model 

2. Driven Terminal 

3. Eigen mode 

 

Exploring User Interface: 

At first glance, we will find a design workspace along with windows., like project manager. At 

the top of the toolbox, we will find systematically grouped icons according to their specific job. 

The tool box contains the following sections 

 

File managing section: 

 
This section, user will find basic operations such as creating a new file, save file, open, cut, copy, 

paste and print etc. 

 

Results. 
2D Reports 
fields 

    Update Finished 

converge 

Solve Loop 



Analysis and relsult section: 

 

In this section, user has all the necessary functions required to run and simulate the model. 

It consists of operations such as analyse, validate,solution setup. It also consists of functions 

capable of plotting the resultd using frequency sweep. 

 

 

Interfacing section:  

 
In this section we will get access to the tools required to move, transform according to planes, 

rotate, hide, zoom in, zoom out, fit contents in a singe view etc. 

 

Geometric section: 

 
This is one of the most important sections. It holds all the necessary tools required to generate a 

geomterical shape. The shapes can be of 2D or 3D. shapes such as stright line,  curved line, 3 

point arc, square(or rectangle), cube, cylinder etc. 

 

Transformation tools: 

 
This section consists of tools requird to tranform the components of the model such as 

unite,substract,intersect,imprint,move,rotate,etc. 

 

Let us take an example of a microstrip patch antenna of frequency 5.8GHz to understand the 

deigning steps. 

Creating a ground plane using geometric section tools. 

 



 

 
                                             Fig 2.1 ground plane  

User can enter the dimensions and position in the properties dialoag box and obtain the desired 

structure. 

Creating a slot: 

 

 
                                             Fig 2.2 create a slot 

 

Enter the required dimensions of the slot and use the subtract option in the transform tools section to 

obtain a slot. 

Use the same step to create a substrate and also to cteate rectangular microstrip patch antenna. 



After designing the microstrip patch, we will add an excitation. 

 
 

 
                                             Fig 2.3 blend excitation 

 

In order to blend the excitation and feedline we use the tool option in the transform section and 

click on the unite tool. 

2.2 Boundary Assignment: 

The boundaries are usually assigned in this step. Boundaries are applied to specifically create 2D 

sheet objects, or surfaces of 3D objects. The twelve boundaries are: 

1. Perfect Electric Conductor (PEC): Built-in HFSS boundary surrounds the solution space 

and constructs a closed model 

2. Radiation: open model is fabricated by this. 

3. Perfectly Matched layer (PML): favored by antenna simulations, these are used to 

generate open model 

4. Finite Conductivity: used for building single layer conductors 

5. Layered Impedance: allows construction of multilayer conductors and thin dielectrics 

6. Impedance: used to create ohm per square material layers 

7. Lumped RLC: allows creation of ideal lumped components 

8. Symmetry: used to enforce a symmetry boundary 



9. Master: used in concurrence with Slave Boundary to replicate infinitely large repeating 

array structures 

10.  Slave: used in association with Master Boundary to facsimile large infinitely repeating 

array structures 

11. Screening Impedance: used to make large screens or grids 

12. Perfect H: allows fabrication of a symmetry plane 

In order to assign boundary conditions, we have to right click on the required material and select 

the desired condition. 

 

  

                                             Fig 2.4 assigning boundary 

 

 

2.3. Assign excitations: 

Following the boundary assignment, excitations are allocated. Corresponding to boundaries, the 

excitations also make a direct impact on the standard of the results that HFSS will impart for a 

given model. Thereupon, an appropriate design and use of excitations is a foremost to obtain 

HFSS results with peak accuracy. 

To assign excitation, we should right click on the required material and select desired excitation. 



 

                                             Fig 2.5 assigning excitation  

 

 

 

2.4. Set up the solution: 

Next step succeeding the excitation is to create a solution setup. Throughout this process, a 

solution frequency, the desired convergence criteria, utmost number of adaptive steps to perform, 

a frequency band over which solutions are desired, and which particular solution and frequency 

sweep method to use are to be created. 

To obtain solution setup, we should click on the HFSS option in the toolbar and select the 

analysis setup and choose solution setup in the dialog box 

 



 
                                             Fig 2.6 solution setup  

 

After selecting solution setup., type your desired frequency in the dialog box as shown below. 

 
                                             Fig 2.7 frequency input  

 

 

 



2.5. Solve: 

After completing four steps by an HFSS, we can analyse the model. The time taken to complete 

the analysis is directly proportional to geometrical model, the solution frequency, and available 

computer resources. 

Click on the validate and analyse all to run the designed model. 

 
                                             Fig 2.8 validate and analyse 

 

2.6. Post-process the results: 

User can post-process the results after completing their analysis. Post-processing of result 

includes scrutinizing the S-parameters or plotting the fields surrounding the structure. Users can 

also inspect the far fields created by an antenna. Substantially, any field quantity or S, Y, Z 

parameter can be plotted in the post-process.  

User can obtain the results in the project manager dialog box and click on the results section to 

get your desired plots. 



 
                                             Fig 2.9 result graph 

 

 

 

 

 

 

 

 

 

 

 

 

 



                                     CHAPTER 3 

SWITCHABLE MICROSTRIP PATCH ANTENNA                  
USING PIN DIODES 

3.1 INTRODUCTION 

Antennas which are capable of modifying certain characteristics such as frequency, polarization  

and radiation pattern are called reconfigurable antennas. Antennas once fabricated cannot be 

modified normally in operating bands. But with this design, switching between bands is possible 

using frequency reconfiguration with six pindiodes as switches. This proposed design 

incorporates an ultra wideband section for frequency sensing and same design is frequency 

reconfigured using pindiodes as switches to get narrow bands for communicating within the 

spectrum. The switches are inserted between the main feed line and extended transmission lines. 

The frequency range of this design is 3.1 to 10.6 GHz. The antenna design,results,conclusion of 

proposed designed are explained in following section. 

3.2 COGNITIVE RADIO 

The advancement in wireless communication applications and the rise in demand on new 

protocols have created an unbalance in the spectrum allocation. It is determined that there is a 

need for a communication protocol that can detect the various free spaces that exist in the 

spectrum, as well as communicate over these white spaces. For this there is a report issued by the 

Federal Communications Commission (FCC) that identifies 70% of the spectrum as 

underutilized and mostly idle. These idle gaps are also known as white spaces. 

The identification of white spaces and the communication over these idle gaps requires a 

communication device to be able to continuously monitor the spectrum, identify idle frequencies, 

process such information, communicate over these discovered white spaces and adapt for future 

use. This device is then required to possess processing potential and cognition ability. Such a 

device was proposed by Dr. Mitola in 1999 and was called a cognitive radio device. 

  



3.2.1 OPERATION OF COGNITIVE RADIO 

The operation of a cognitive radio system is divided mainly into two tasks. In the first task, a 

cognitive radio device searches and identifies any part of the spectrum that is idle which is called 

as spectrum sensing. The second task consists of achieving a good mode of communication by 

allocating the appropriate channel to be used, this is called as signal transmission. The cognitive 

radio antenna systems must operate around the heavily congested spectrum and broadcast over 

underutilized bands to access various wireless standards set by FCC. Therefore, cognitive radio 

systems are considered a good solution for unbalanced spectrum occupancies and constitute the 

future of efficient wireless communication systems.  

                                        

                                 Fig 3.2.1 Cognitive radio mechanism 

The radio spectrum is divided into licensed and unlicensed frequencies. The licensed spectrum is 

for the exclusive use of designated users. For instance, it includes the UHF/VHF TV frequency 

bands. The unlicensed spectrum can be freely accessed by any user, with certain rules such as by 

not exceeding a defined limit for transmission power. In order to share the spectrum with 



licensed users without disturbing them, and meet the better quality of service requirement of 

applications, each CR user in a CR network must determine the portion of spectrum that is 

available, which is known as Spectrum sensing. Select the best available channel, which is called 

Spectrum decision. Coordinate access to this channel with other users, which is known as 

Spectrum sharing. Vacate the channel when a licensed user is detected, which is referred as 

Spectrum mobility. 

 

 

 

 

 

 

 

                                             Fig 3.2.2 Cognitive cycle 

 

                                        Fig 3.2.3 Primary and Secondary users 



So, a cognitive radio antenna system has access to the software-controlling processor of a 

cognitive radio device and reconfigures its operation based on observations made by the sensing 

antenna.                                                                                                                         

3.3 PINDIODES 

A microwave PIN diode is a semiconductor device that operates as a variable resistor at RF and 

Microwave frequencies.  It is a current controlled device. The microwave PIN diode's small 

physical size compared to a wavelength, high switching speed, make it an ideal component for 

use in miniature, broadband RF signal control circuits. The PIN diode has the ability to control 

large RF signal power while using much smaller levels of control power.                                                   

         

   Fig 3.3.1 pindiode as forward bias                          Fig 3.3.2 pindiode as reverse bias 

When the forward bias control current of the PIN diode is varied continuously, it can be used for 

attenuating, leveling, and amplitude modulating an RF signal. When the control current is 

switched on and off, or in discrete steps, the device can be used for switching, pulse modulating, 

and phase shifting an RF signal. The microwave PIN diode's small physical size compared to a 

wavelength, high switching speed, and low package parasitic reactances, make it an ideal 

component for use in miniature, broadband RF signal control circuits. In addition, the PIN diode 

has the ability to control large RF signal power while using much smaller levels of control 

power. 

The performance characteristics of the PIN diode depend mainly on the chip geometry and the 

processed semiconductor material in the intrinsic or I - region, of the finished diode. When the 

diode is forward biased, holes and electrons are injected into the I-region. 



If the PIN diode is reverse biased , there is no stored charge in the I-region and the device 

behaves like a Capacitance (CT) shunted by a parallel resistance (RP). 

3.4 DESIGN OF MICROSTRIP PATCH ANTENNA USING PINDIODES 

The antenna is designed in Ansoft HFSS software tool. The design is simulated for five cases 

based on required configurations. The following are the required dimensions for the design. 

 

 

 

 

 

 

 

 

 

 

                        Fig 3.4.1: structure of switchable microstrip patch antenna 

 

Table 3.1: Switching Configurations 

C SW1 SW2 SW3 SW4 SW5 SW6 
C-I OFF OFF OFF OFF OFF OFF 
C-II ON OFF OFF OFF OFF OFF 
C-III OFF OFF OFF ON OFF OFF 
C-IV OFF ON OFF ON ON OFF 
C-V OFF OFF OFF OFF ON OFF 
 



Table 3.2: Dimensions of switchable microstrip patch antenna using pindiodes. 

S. NO PARAMETER              DESCRIPTION    DIMENSIONS 

1 L Length of the substrate 40.00mm 

2 L1 Length of main feed line 22.07mm 

3 L2 Length of  transmission line 5,6 2.00mm 

4 L3 Length of slot cut in ground 2.90mm 

5 L4 Length of the ground 20.75mm 

6 L5 Length to transmission line 1,2 14.00mm 

7 L6 Length to transmission line 3,4 8.16mm 

8 L7 Length to transmission line 5,6 3.86mm 

9 Ls Length of transmission lines 3,4 2.00mm 

10 Lp Length of patch 1 11.75mm 

11 W Width of the ground and 
substrate 

40.00mm 

12 Wf Width of main feed line 2.36mm 

13 Wc Width of corner slot 2.40mm 

14 Ts Thickness of substrate 1.6mm 

15 Ws Width of switch 2.90mm 

16 Wp Width of patch 1 15.74mm 

17 Wsp Width of patch 2 6.61mm 

18 Lsp Length of patch 2 5.53mm 

19 Lc Length of corner slot 2.40mm 

 

 

 

 

 

 



 Pindiode as forward bias:  

 

C1 , C2 = 1µF  

         L  = 0.6 nH 

         R  = 1 Ὠ 

 Pindiode as reverse bias:  

 

C1 , C2 = 1µF  

         C3 = 0.5 pF 

          L = 0.6 nH 

          R = 1 KὨ 

 

 

 

C1 L R C2 

C3 

C1 L R C2 



3.4.1 Design steps: 

The antenna is simulated for configuration-1. In this configuration all switches are in off 

condition, ie., all the pindiodes are in reverse bias. All the required dimensional measurements 

for antenna design are calculated.  

Step 1: Launch the HFSS software. 

Step 2: In the HFSS window, from menu item click file and select new. 

Step 3: From project menu, select insert HFSS Design. 

Step 4: Select the menu item HFSS > Solution Type > Driven Terminal. 

Select the menu item 3D Modeler > Units > mm 

Step 5: Now go to menu and Click on rectangle. Windows pops up and define all the 

specifications of ground plane and name it as ground and subtract a slot of required dimensions 

from it. 

 
                                    Fig 3.4.2: Ground plane in HFSS window 

Step 6: From menu, click on box (for substrate).A window pops up and defines all the 

specifications of the box. Name the box as substrate and define its dimensions. 



 

                                   Fig 3.4.3: After placing substrate  

Step 7: Now place the vertical patch by specifying all  its dimensions. 

 

                                     Fig 3.4.4: After placing main patch 

 

Step 8: Insert main feed line with specified dimensions and join the patch and transmission line. 



 

                                     Fig 3.4.5: After placing main patch 

Step 9: Now subtract the 4 slots with specified dimensions at the corner of the main patch. 

 

                                Fig 3.4.6: After cutting slots from main patch 



Step 10: Now insert the first transmission line with specified dimensions by selecting rectangle 
from item menu. 

 

                                    Fig 3.4.7 First extended transmission line 

Step 11: similarly insert all other 5 transmission lines with specified dimensions.  

 

                                    Fig 3.4.8.1 Second extended transmission line 



 

 

                                    Fig 3.4.8.2 Third extended transmission line 

 

 

                                    Fig 3.4.8.3 Forth extended transmission line 



 

                                    Fig 3.4.8.4 Fifth extended transmission line 

 

 

 

                                    Fig 3.4.8.5 Sixth extended transmission line 



Step 12: Now create feed point with required dimensions by changing drawing plane to ZX 

direction. 

 

                                                     Fig 3.4.9: After creating feed point 

Step 13: Assign boundary to ground as finite conductivity and use  material as copper. 

Right click on ground > assign boundary > finite conductivity > use material > copper 

                                                                                                                       
.                                 Fig 3.4.10: After assigning boundaries 



Step 14: Similarly assign boundary to all patches as finite conductivity and use  material as 

copper. 

Step 15: Assign FR4 material to substrate. 

 

                                   Fig 3.4.11: Assigning material for substrate 

Step 16: Add lumped port for excitation with reference to ground. 

Right click on feed point > assign excitation > lumped port > ground(use as reference).

                                                                 



                                 Fig 3.4.12: After assigning Excitation 

 

                                                       Fig 3.4.13: After assigning Excitation 

 

Step 17: Insert radiation box with specified dimensions such that the design such lie inside the 

radiation box. 



 

                              Fig 3.4.14: Assigning radiation box for designed antenna 

Step 18 : Assign radiation characteristics to radiation box. 

Right click on radiation box > assign boundary > radiation 

 

                              Fig 3.4.15: Assigning boundary for radiation box 



Step 19: Now insert switches (pindiodes) and assign the resistance, inductance, capacitance 

values as per off condition. 

Right click > assign boundary > lumped RLC > select resistance/ inductor/ capacitor > define 

current flow with new line. 

 

                              Fig 3.4.16.1: inserting pindiodes 

 



 

                              Fig 3.4.16.2: assigning properties for pindiodes 

 

                              Fig 3.4.16.3: assigning values and defining current flow for lumped RLC 

 



 

Step 20: Assign operating frequency. 

HFSS > analysis setup > add solution setup 

 

                              Fig 3.4.17.1: adding solution frequency   

 



 

                              Fig 3.4.17.2: After adding solution frequency   

Step 21: To specify the start and stop frequency of the plot select HFSS> Analysis set up > Add 

Frequency Sweep. 

 
                                  Fig 3.4.18: Assigning Sweep setup 

 



Step 22: To view any errors in the design, click on HFSS > Validation Check and then to analyze 

the design click on HFSS > Analyze all. 

 

 

                                     Fig 3.4.19: Validation check and Simulation 

                                             

                                                 Fig 3.4.20: Analysis setup 

 

Step 23: After completion of the simulation process, the results are observed through select 

HFSS > Results. These are the results for configuration1 when all switches in OFF condition 

.Step 24: To observe the results for remaining four configurations follow the same above steps 

and additionally change the configuration of RLC circuit of pindiode for forward bias as per the 

configuration ON conditions. 



3.5 RESULTS: 

Here we obtain two main parameters (Return loss and Gain) as results.                                   

Return loss (S11) is a measure of how much power is reflected back at the antenna port due to 

mismatch from the transmission line. 

Antenna gain is the ability of the antenna to radiate more or less in any direction compared to a 
theoretical antenna.  

 

                          Fig 3.4.21.1: Return loss of configuration1 (-31 dB) 

 

 

                              Fig 3.4.21.2: Gain of configuration 1 ( 1.4 dB) 



 

 

                           Fig 3.4.22.1: Return loss of configuration 2 (-18.7 dB) 

 

 

                                 Fig 3.4.22.2: Gain of configuration2(2.1 dB) 



 

                           Fig 3.4.23.1: Return loss of configuration 3 (-15.52 dB) 

 

 

                       Fig 3.4.23.2: Gain of configuration 3 (2.8 dB) 



 

                        Fig 3.4.24.1: Return loss of configuration 4(-16.6 dB) 

 

 

 

 

                       Fig 3.4.24.2: Gain of configuration 4 (4.07 dB) 



 

                         Fig 3.4.25.1: Return loss of configuration 5 (-22.02 dB) 

 

 

                            Fig 3.4.25.2: Gain of configuration 5 (1.7 dB) 

 

 

 



Table 3.3: Summary of results obtained for the proposed design. 

Configuration  Return loss(db) Gain (db) Frequency (GHz) 

        I -31 1.4 3.2 – 8.5 

       II -18.7 2.1 3.6 – 6.2 

       III -15.52 2.8 5.2 – 8.2 

       IV -16.6 4.07 6.6 – 7 

        V -22.02 1.7 7.8 – 10.2 

 

3.6 CONCLUSION: 

This work reports a frequency reconfigurable antenna that can be reconfigured as an UWB 

antenna and narrow band antennas .Here we use pindiodes as switches. Configuration I with all 

switches OFF combination allows the antenna to operate in the UWB (3.2 to 8.5 

GHz).Configuration II, III, IV, and V, collectively allow the antenna to operate from 3.6 to 10.2 

GHz as five narrow bands. Configuration I makes the antenna suitable for spectrum sensing part 

of Cognitive Radio, and Configurations II to V allow the antenna to be used for communicating 

within the UWB spectrum. So, from the obtained results we can conclude that signal 

transmission in narrow and widebands can be achieved through switching using pindiodes. 

 

 

 

 

 

 

 

 

 

 



                                                    CHAPTER  4 

SWITCHABLE MICROSTRIP PATCH ANTENNA             
DESIGN AND SIMULATION RESULTS USING MEMS 

 

4.1 INTRODUCTION 

Reconfigurable antennas have attained much attention in recent years. These antennas are able to 

modify themselves with respect to the frequency, Bands, polarization, characteristics, radiation 

pattern, and combinations of the above. A single reconfigurable antenna is capable of 

accommodating the features of a number of antennas. This proposed antenna is designed to 

achieve Band reconfigurability. The reconfigurability of the antenna is   obtained   by inserting 

switches like RF-MEMS. RF-MEMS Switches are found to be dependable over microwave and 

milli meter-wave range applications with rapidness in switching, higher linearity and isolation, 

excellent adaptability, lower distortion rates. 

The proposed work can achieve both spectrum sensing and signal transmission using same 

design. Here, the UWB and Narrow band characteristics are obtained by presenting rectangular 

patch band reconfigurable antenna in this design using various switching configurations. These 

configurations are considered as per the Federal Communications Commission (FCC) 

regulations for the UWB technology and assigned the unlicensed spectrum from 3.1 to 10.6 GHz 

for Cognitive radio applications. Gain, Return loss, Frequency bands are obtained through 

switching in between the bands of preferred configurations. The antenna design, results, 

conclusion about the results of the proposed design are explained in the following sections. 

 

4.2 MEMS 

Micro electro mechanical Systems (MEMS) have been developed since the 1970s for pressure 

and temperature sensors, accelerometers and other sensor devices. The one main criterion of 

MEMS is Sort of mechanical functionality whether or not these elements can move. These 

actually refer to miniature mechatronic systems which are fabricated using VLSI technology 



4.2.1 Functionality of MEMS: 

                           

                                   Fig 4.2.1.1 Basic function of MEMS 

MEMS Converts physical stimuli, events and parameters to Electrical, Mechanical, and optical 

signals and vice versa. Performs actuation, sensing and other functions. 

 

4.2.2 Features and Benefits of MEMS: 

MEMS are used for Sensing, Actuation (passive micro-structures), Cost reduction, Increase 

functionality, Improve reliability, Small in size as in the range of micrometer to millimeter, 

Techniques and processes to design and create miniature systems and miniature embedded 

system, Fewer defects per chip, Reduce noise and improve sensitivity. 

MEMS introduced many benefits of size reduction on the electrical domain and also in terms of 
Speed for High Frequency, Low Thermal time const. Power Consumption for less Actuation 
Energy & Heating power. Complexity for High Integration density & functionality, Faster 
switching, Low loss, Larger networks and Fast Analysis speed. 

4.3 DESIGN OF SWITCHABLE MICROSTRIP PATCH ANTENNA 

The switchable microstrip patch antenna is designed by using RF MEMS and also by using the 

Ansoft HFSS simulation tool. The design is simulated for five cases based on the required 

configurations. 



4.3.1 Design steps: 

The antenna design is simulated for configuration 1 when all the switches in OFF condition. 

Simulation steps are shown in Fig 5.1-5.13 are as follows 

Step1: Launch the Ansoft HFSS. 

Step2: In an HFSS window, from the menu click file>New. 

Step3: From the Project menu, select insert HFSS Design. 

Step4: Select the menu item HFSS > Solution Type > Driven Terminal. 

           Select the menu item 3D Modeler > Units > mm 

Step5: Now go to menu and Click on rectangle. Windows pops up and define all the 

specifications of ground plane and name it as ground 

                        Fig 

4.1: 

Ground plane in HFSS window 

Step6: Now go to menu and Click on box. A window pops up and defines all the specifications 

of a substrate. i.e. type of substrate and the dimensions. Name the box as substrate. Also place 

vertical patch by defining all the specified dimensions. 

 

 

  



 
                  
              Fig 4.2: After placing substrate and main patch 

Step7: Now cut the four slits from the edges of Rectangular patch (main patch) using specified   

dimensions by clicking on main patch. 

 

                         Fig 4.3: After cutting edge slots of main patch 

 

Step8: Assign perfect E to ground, vertical patch and horizontal patch 

           Select Edit > Select > By Name > patch1.    



           Select HFSS> Boundaries > Assign > Perfect E 

Step9: Now insert all the 6 extended transmission lines by using specified dimensions which 

were obtained from the calculations. 

 

 
                               

                                    Fig 4.4.1 First extended transmission line 

 

 

 



 

                                    Fig 4.4.2 Second extended transmission line 

         

 
                          
                    Fig 4.4.3 third extended transmission line. 
 
 



 

 

                        Fig 4.4.4 Fourth extended transmission line 

 

 

 



 

                         Fig 4.4.5 Fifth extended transmission line 

 

 

  

                         Fig 4.4.6 Sixth extended transmission line 

 

 

Step10: Now assign the specified dimensions and create a feed point. Then assign excitation to 

the feed point. 



 
                                                       Fig 4.5: After assigning Excitation 

Step11: Assign boundary to ground as finite conductivity and use material as copper. 

Step12: Add lumped port for excitation with reference to ground. 

Step13: Assign boundary to patches as finite conductivity and use  material as copper and assign 
material FR4_epoxy for substrate. 

                  

                                                 

Fig 4.6: 

After 

assigning 

boundaries 



 
                                   Fig 4.7: Assigning material for substrate 

Step14: Now assign the radiation box for the proposed design antenna. 

      Select HFSS > Excitations > Assign > Radiation. 

 

 

 

                              Fig 4.8: Assigning radiation box for designed antenna 

 



 

 

Step15: Assign boundary as finite conductivity with copper material for ground. 

 

 
                                   Fig 4.9.1: Assign boundary for ground  

 



 
                                      Fig 4.9.2: Assigning material to ground 

 

 

Step16: To simulate the design antenna, select HFSS> Analysis set up > Add solution set up. A 

window pops up, in that window define the operating frequency. To specify the start and stop 

frequency of the plot select HFSS> Analysis set up > Add Frequency Sweep. 



 
                              Fig 4.10: After adding solution frequency   

 
                                  Fig 4.11: Assigning Sweep setup 

 

 

 

 



Step16: To view any errors in the design, click on HFSS > Validation Check and then to analyze 

the design click on HFSS > Analyze all. 

 

 
                                     Fig 4.12: Validation check and Simulation 

                                                     

                                                  Fig 4.13: Analysis setup 

Step17: After completion of the simulation process, the results are observed through select HFSS 

> Results. These are the results for configuration1 when all switches in OFF condition 

Step18: To observe the results for remaining four configurations follow the same above steps and 

additionally connect the MEMS in between the extended transmission and main feed line as per 

the configuration ON conditions. 



Step19: After optimization, the final design of Switchable microstrip patch antenna is shown in 

Fig. 5.14 and the dimensions of the antenna is shown in table 5.16.  

  

 

 

 

 

 

 

 

 

 

 

 

 

        

                          Fig 4.14: Switchable microstrip patch antenna 

 



             Fig 4.15.1 config 2                               Fig 4.15.2 config 3 

                        Fig 4.15.3 config 4                              Fig 4.15.4 config 5 

Table 4.1: Switching Configurations 

C SW1 SW2 SW3 SW4 SW5 SW6 
C-I OFF OFF OFF OFF OFF OFF 
C-II ON OFF OFF OFF OFF OFF 
C-III OFF OFF OFF ON OFF OFF 
C-IV OFF ON OFF ON ON OFF 
C-V OFF OFF OFF OFF ON OFF 
 

Table 4.2: Dimensions of switchable microstrip patch antenna using MEMS. 

S. NO PARAMETER              DESCRIPTION    DIMENSIONS 

1 L Length of the substrate 40.00mm 

2 L1 Length of main feed line 22.07mm 

3 L2 Length of  transmission line 5,6 2.00mm 

4 L3 Length of slot cut in ground 2.90mm 

5 L4 Length of the ground 20.75mm 

6 L5 Length to transmission line 1,2 14.00mm 

7 L6 Length to transmission line 3,4 8.16mm 

8 L7 Length to transmission line 5,6 3.86mm 

9 Ls Length of transmission lines 3,4 2.00mm 

10 Lp Length of patch 1 11.75mm 

11 W Width of the ground and 
substrate 

40.00mm 



12 Wf Width of main feed line 2.36mm 

13 Wc Width of corner slot 2.40mm 

14 Ts Thickness of substrate 1.6mm 

15 Ws Width of switch 2.90mm 

16 Wp Width of patch 1 15.74mm 

17 Wsp Width of patch 2 6.61mm 

18 Lsp Length of patch 2 5.53mm 

19 Lc Length of corner slot 2.40mm 

4.4 RESULTS: 

Switchable microstrip patch antenna resonates at a frequency of 3.2-8.6GHz with a return loss of 
-33.02dB and gain of 1.54dB for configuration1. The design resonates 3.7-6.5GHz with a return 
loss of -20.1dB and gain of 2.4dB for configuration2, 5.2-8.2GHz frequency, return loss of -
19.81dB and gain of 1.4dB for configuration3.For configuration4, this design achieves 
resonating frequency of 6.8-7.2Ghz, return loss of -23.8dB and gain of 2.505dB and for the last 
configuration it achieves frequency of 7.8-10GHz, return loss of -22.1dB and gain of 2.4dB. 

Return loss (S11) is a measure of how much power is reflected back at the antenna port due to 
mismatch from the transmission line. 

 

                          Fig 4.16.1: Return loss of configuration1 (-33.02dB) 



Antenna gain is the ability of the antenna to radiate more or less in any direction compared to a 
theoretical antenna.  

                              Fig 4.16.2: Gain of configuration 1 ( 1.54dB) 

 

                           Fig 4.17.1: Return loss of configuration 2 (-20.1dB) 

 

 



 

                                 Fig 4.17.2: Gain of configuration2(1.54dB) 

 

 

 

 

 

 

 

 



 

                           Fig 4.18.1: Return loss of configuration 3 (-19.81dB) 

 

 

                       Fig 4.18.2: Gain of configuration 3 (1.4dB) 

 

 

 

 



 

 

                        Fig 4.19.1: Return loss of configuration 4(-23.8dB) 

 

 

                       Fig 4.19.2: Gain of configuration 4 (2.505dB) 

 

 

 



 

 

 

 
                         Fig 4.20.1: Return loss of configuration 5 (-22.1dB) 

 
                            Fig 4.20.2: Gain of configuration 5 (2.4dB) 

The results are summarized in the following table. 

 

Table 4.3: Summary of results obtained for the proposed design. 



Configurations Return loss Gain(dB) Frequency (GHz) 
Configuration-I -33.02 1.54 3.2-8.6 
Configuration-II -20.1 2.4 3.7-6.5 
Configuration-III -19.81 1.4 5.2-8.2 
Configuration-IV -23.8 2.505 6.8-7.2 
Configuration-V -22.1 2.4 7.8-10 
 

4.5 CONCLUSIONS: 

This proposed design reports a reconfigurable antenna that can be reconfigured as a UWB 
antenna and narrow band antenna. This is achieved by inserting MEMS into the design such that 
they built the connection and disconnection between the extended transmission line and main 
feed line. Configuration-I makes the antenna approach for spectrum sensing part of Cognitive 
Radio, and Configurations II to V allow the antenna to be used for communicating within the 
UWB spectrum. As configuration I allows the antenna to operate in UWB range (3.2-8.6 GHz) 
and the remaining four configurations collectively allow the antenna to operate in 3.7-10GHz 
range. Hence the proposed design can be the good norm to achieve Cognitive radio applications.  
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